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Queira

vocé ou nao, este é o velho Mac OS que aprendemos a
amar e suportar. A base do sistema é € iSso traz
varias O sistema ¢ (mesmo que
s6 vocé utilize a maquina), possui uma série de ferramentas
mais proprias de um sistema (como programas que
servem paginas Web e FTP), e tem uma opgao de interface de

O Terminal pode parecer uma ou
um passo atras para macmaniacos da gema, que acham (com
toda a razdo) que a € uma forma mais evoluida
de Mas a verdade é que, para
aplicagdes como administragio remota e configuracio de ma-

para que eles se sintam Nestas paginas, escolhemos

os melhores do OS X, para os
macmaniacos mostrarem para 0s amigos
ou Hoje, coisas simples como mudar icones do

HD ou instalar sons de alerta ainda exigem uma ida ao Ter-
minal, mas isso acontece s6 porque a Apple ainda

de deixar o OS X totalmente redondo. A cada dia que
passa, aparecem e que tornam mais

executar essas tarefas. Se vocé quer fazer algum dos

truques ensinados aqui, mas nio estd a fim de mexer no

basta ter um pouco de Para os que querem se
iniciar no maravilhoso mundo dos comandos cripticos, prepa-

quinas, a linha de comando é o
planos de domina¢io mundial da Apple
para o

®

Root ¢é o super-usudrio, a pessoa que tem con-
trole total sobre o sistema operacional. O
usudrio normal tem o status de admin (admi-
nistrador), mas nao pode mexer em arquivos
do sistema. O root tem poderes ilimitados.
Ficar usando a miquina como root em vez de
admin pode ser necessirio em alguns casos,
mas também é um perigo se feito por pessoas
leigas ou mal-intencionadas. Tanto ¢ perigoso
que a Apple o deixou desabilitado por default.
Veja agora como habilitd-lo.

Abra o programa NetInfo Manager, localiza-
do em /#pplications/Utilities,

No NetInfo Manager, acesse 0 menu Domain
» Security » Authenticate.

@ Netinfo Manager JBINCOM Edit Directory Options Window Help
Open...
Qpen By Tag.

=
Close
Directory Browser

!

Security

servers...

Manage Domains

Save Backup...

Restore From Backup...

Page Setup...
Print... ®P

Directory: /

Froperty Vatoets)
master localhostflocal
trusted_networks

() Click the lock to prevent further changes.

Entre com seu /ogin normal de admin.

Novamente no menu Security, selecione
Enable Root User.

Escolha uma senha para o root (se s6 vocé
usa o Mac, ela pode ser a mesma do admin,
para nio complicar) e confirme.

Desligue o NetInfo Manager e dé Log Out
(G3(Shift@ no Finder).

Agora vocé pode “logar” de novo como 7oot,
usando a senha que escolheu.

Pronto. O super-usudrio estd habilitado. Mas
use-o somente se vocé souber mesmo o que

E como esta dentro dos

do Mac OS X, a linha de comando é fundamental

um
aproveitar o

& Change Root Password

%

Enter a new root password for domain: /

Password |« .

estd fazendo. Usar o Mac OS X como root é o
melhor jeito de escangalhar o seu sistema sem
querer. Mais elegante e seguro € utilizar o
comando zu no Terminal. Esse comando muda
temporariamente a sua identidade. Se vocé digi-
tar apenas su, o shell vai entender que vocé
quer mudar para root, e pedird a senha. Depois
que terminar o que tinha que fazer como root,
digite exit para voltar a identidade normal.

esloeled

Uma das coisas mais “show” do OS X é que dd
para deixar as janelas do Terminal transparen-
tes. Essa € uma preferéncia que nao ¢ acessivel
de dentro do programa; por isso, sera neces-
sario um pequeno hack.

Abra o programa Terminal.

Digite o seguinte comando:
defaults write com.apple.Terminal
Terminaldpaqueness 0.5
Esse comando manda adicionar uma linha de

Q Qualquer mané esforcado
pode experimentar fazer

@@@ S6 para quem nao tem

nojo de digitar comandos

Nao tente isso sem acom-
@Q@Q@ panhamento de um adulto

ramos também um

dos dois lados da

e a primeira parte de
Divirta-se. N3o é sempre que pode se
simultaneamente.

texto a0 arquivo de preferéncias do Terminal
(com.apple.Terminal). O nimero que aparece no
exemplo como 0.5 pode ser qualquer coisa
entre 0.0 e 1.0 (0 ou 100% opaco). No exemplo
abaixo, foi usado 0.75 (75%).

E possivel adicionar sons de alerta personaliza-
dos a0 Mac OS X. Eles precisam estar no forma-
to AIFF de 16 bits, estéreo. Caso o formato dos
arquivos seja outro, utilize o QuickTime Pro,
iTunes ou outra ferramenta de sua preferéncia
para converté-los para essas especificacoes.
Com os arquivos de som prontos, temos duas
opgoes: sons para um Unico usudrio ou para
todo mundo que usa o seu Mac.

Se s6 voce for usar os sons, mova seus arqui-
vos AIFF para a seguinte pasta (diret6rio) do
Mac OS X: ~/Library/Sounds/ (no Unix, o sinal ~
¢ a mesma coisa que “Home”, que ¢ a sua pasta
pessoal dentro de Users).

No caso de querer disponibilizar os sons
para todos os usudrios, ignore a instrucao
acima; dé um Log Out, entre de volta como
usuario 700t € copie ou mova seus arquivos
AIFF para o diret6rio #SystemyLibrarysSounds.
Faca um Log Out e entre de volta como
usudrio normal.

Para conferir se estd tudo bem, acesse o
System Preferences, secio Sound, e veja se 0s



& sons adicionados estao lista-
dos. Teste-0s. Se nao der certo,
verifique se os arquivos estao
mesmo no formato correto.

ool

Alterar seus icones no Mac OS X é, teorica-
mente, a mesma coisa que nas versoes anteri-
ores do Mac OS. No Mac OS clissico, os icones
podiam ser
copiados e cola-
dos na janela de
informagoes Get

Info: Color Classic

olor Cl

Show: | General Information

Kind. Folder
Info. Pois tam- SR
bém € assim no S
OS X BaSta Modified:

selecionar o
icone no Finder
e dar Get Info
no menu File
(ou E@M). A
janela de infor-
macoes do arquivo € similar a de antigamente.
Para copiar o icone, clique nele e selecione
Copy (®)(C)). Agora, uma boa novidade: nao é
preciso fechar a janela de Get Info e abri-la de
novo. E s6 selecionar o outro icone no Finder e
o conteudo da janelinha mudara de acordo. Ai
basta colar (@)(V)) o icone e pronto.

Locked
Comments:

QOR

0 método tradicional de mudar icones funciona
com tudo? Ndo. A sua pasta Home, com o icone
brega da casinha, s6 pode ser mudada se vocé
estiver “logado” como root. Pior ainda: os
icones de itens genéricos do sistema, como
CDs, HDs e discos externos, nio podem ser
mudados. Mas existem duas maneiras de con-
tornar isso. A primeira ¢ uma gambiarra que
vale s6 para os icones dos HDs.

Crie atalhos (aliases) dos seus discos rigidos
e troque os icones deles.

Copie esses atalhos para a pasta ~/Desktop
(isto €, a pasta Desktop que fica dentro da sua
pasta em Users).

Reinicie pelo X.

No menu Finder
» Preferences,
desligue a op¢io
“Show Disks on
the Desktop”.

Arraste os icones
dos atalhos para
onde vocé quiser
e pronto.

A desvantagem
desse método €
que, quando voce

) (L () sl

L s Y e e LT O O

montar um CD, cartucho Zip ou HD de outra
miquina acessado pela rede, o seu icone nao
aparecerd no desktop e ficard visivel somente
nas janelas do Finder.

Finder Preferences

Desktop Picture: u Select Picture..
A

lcon Size: = \ i = _
(R B Rt B e e R |

small Large

Icon Arrangement: () None
® Always snap to grid

Disks: @ Show disks on the Desktop

Disks include hard dis rvers and CDs.

E Keep the same view when you open a folder in the
same window

esioelocleoles)

Este é um hack profica, complicado e que exige
uma maozinha do Classic também — nio é para
os de coracao sensivel. Este tipo de modifi-
cacdo é somente por sua propria conta e risco.
Siga estas instrugoes apenas se voce odeia de
paixio aquelas “fotos” de HD no desktop.

No Mac OS classico, os icones genéricos do sis-
tema (pastas, discos rigidos, CDs, Lixo e muitos
outros) podem ser alterados modificando-se
diretamente os recursos do sistema operacio-
nal. Para fazer isso, € preciso usar o programa
ResEdit. No Mac OS X, muitos dos icones ge-
néricos estao contidos em um arquivo chamado
HIToolhax rare, escondido em um canto remoto
no sistema.

Arquivos de Macintosh geralmente possuem um
resource fork, um data fork ou ambos. Os re-
cursos contidos no HiTaalbozrsre sao do tipo
data fork. Para editar os icones, serd necessirio
mover esses recursos para um resource fork. O
modo mais ficil de realizar isso € utilizando o
software QuickConvert (http://homepage.mac.
com/dmaclach/ tools/#uickConvert). Voce vai pre-
cisar também do Iconographer (www.macape.
com/products/iconographerhiml), um editor de
icones para o Mac OS cldssico que suporta os
icones do OS X.

Localize o HiToolboxrsre e faca uma copia de
becape para ter como recuperar o sistema em
caso de erro. Existem diversas maneiras de fazer
isso, mas recomendamos utilizar o Terminal.
Depois de abrir o aplicativo, digite o seguinte:
cd #System/Library/Frameworks/Carbon,
frameworksYersions A/Frameworks HIToolbox.
frameworkYersions &/ Resources
(A gente avisou que era um “canto remoto”
do sistema...)

Digite:
sudo cp HIToolbox.rsrc HIToolboxBACKUP.Fsre
Entre sua senha quando solicitada. (Note a men-

sagem de adverténcia — ela foi criada para o sis-
tema BSD, dai esse papo de Administrator.)

/binjtesh (ttypl)

10 cp HIToolhox.rsre HIToal boXBACKUP

e from the local
se tro things:

Depois de fazer a copia de seguranca do
HIToolbox.rsre, faca uma nova cdpia dele para ser
editada. Digite o comando abaixo no Terminal;
uma copia do arquivo aparecerd no seu desk-
top. Mantenha o Terminal aberto; vocé preci-
sard dele em breve. Digite:
cp HIToolboxrsre ~/Desktop/HIToolbox rsre

Jbinjtcsh (ttyp2)

Arraste o arquivo para o QuickConvert, a fim
de mover o contetido do data fork para o
resource fork (vocé nao receberd nenhuma
mensagem de confirmacio).

Abra o arquivo modificado com o Iconogra-
pher. O HiToolbo:rsre contém ao redor de 199
icones originais do sistema, além de outros
recursos. O Iconographer serve para vocé visua-
lizar e editar
cada um dos
icones e suas
mdscaras. Se
voce visualizar
apenas um
icone genérico
e nio a fami-
lia, serd pre-
ciso refazer o
processo.

Para alterar
os icones ori-
ginais, vocé
pode escolher
uma variedade
de icones espalhados pela Internet. Uma vez
escolhidos os icones, abra-os com o Icono-
grapher e selecione Edit » Copy » Icon Family.

Escolha o icone que deseja alterar no
HIToolbaxrsre. Dé Edit » Paste » Icon Family.
Salve o arquivo; repita o processo quantas vezes

[ & rie QY 1con dow Help

Normally

Clear
Select
Transform
Adj

As Icon and Mask




precisar até terminar a
tarefa. Se ligue que todos
os itens do mesmo tipo
ficardo com o mesmo
icone; portanto, escolha
um bem bonito.

Agora vocé precisard
mover o conteddo do

resource fork modificado
de volta para o data fork.
Para isso, utilize 0 Quick-
Convert. Aviso: Falhas ao

copiar o resource fork para o data fork antes de instalar a copia modificada
do HiToalbox.rsre causardo um problema: vocé ndo conseguird reiniciar seu
Mac! Se nio est seguro do que estd fazendo, nao siga adiante!

Seu arquivo modificado estd pronto para ser instalado.
Na janela do Terminal, digite o seguinte para sobrepor o HIToolbo::.rare

original a versao personalizada:

sudo v ~/Desktop/HIToolbox rsre HIToolbox. st
Entre com sua senha de administrador quando solicitada.

Para visualizar as modificacdes, é preciso
reiniciar o Finder. Isso pode ser feito selecio-
nando Force Quit no Apple Menu ou pressio-
nando ()(Option)(Esc). Melhor ainda: dé Log
Out e entre de volta. Ou reinicie o Mac.

No futuro, se vocé quiser restaurar os
icones originais, abra o Terminal e digite o
seguinte, entrando com sua senha de admi-

nistrador quando solicitado:

Galat DegH L)

cd SSystern/Library/Frameworks/Carbon frameworkYersionss &/ Frameworks/
HIToolbow frameworkYersionsd &/ Resources
sudo vy HIToolboxBACKUP. Farc HIToolbox Fsre

eolseled

O Genie € a animacao de minimizagao
de janelas no Dock. Se voce ji enjoou
do efeito original, existem outros dois a
escolha — s6 que, por alguma razao mis-
teriosa, a Apple nao os incluiu nas
preferéncias do Dock. Nada que nio se
resolva com um simples comando.

Abra o Terminal. Digite:
defaults write com.apple.Dock mineffect
suck

Abra o ProcessViewer e dé Force Quit
no Dock. Ap6s alguns instantes, ele
abrira de volta. Minimize uma janela; o
efeito da animacao terd mudado para
um outro, em que a janela é “puxada”
por um dos cantos.

Repita o comando no Terminal, s6
que com a varidvel scale:
defaults write com.apple.Dock mineffect
sale
Dica: voce sempre pode teclar (1) no
Terminal para ele repetir a itima coisa
que foi digitada, dar somente no
texto a ser modificado e redigitd-lo sem
precisar escrever tudo de novo.
D¢ Force Quit no Dock novamente.

Sabe o que é uma tarefa no Mac OS X? Ou entdo, o que quer

dizer kernel? Termos que fazem parte das conversas de bar dos

geeks unixistas sdo um verdadeiro dialeto para os macmaniacos

acostumados aos “restarts com Shift”, Option-isso ou Maga-

aquilo. E claro que os velhos termos e mandamentos do Mac OS

classico ainda predominam, mas sempre é bom conhecer a ter-

minologia geek para ndo dar vexame na frente dos seus amigos

linuxeiros. Sendo assim, nés da Macmania pegamos alguns

alfarrabios sobre Unix e conseguimos desvendar seus mistérios,

traduzindo tudo para uma linguagem mais “amigavel”.

A arte de distribuir o tempo de uso
da CPU (ou CPUs, num computador
multiprocessado) para os

ativos. 0 Mac OS classico tinha
apenas um sistema basico de agen-
damento, que ficou inalterado des-
de tempos imemoriais para manter
a compatibilidade com programas
que rodavam nas versdes anteriores
do Mac 0S. Com o 0S X, tudo
muda: o X é multithreaded preemp-
tivo e , além de ser
otimizado para usar mais de

um processador.

Interface visual padrdo do Mac 0S
X. No mundo tradicional, esse
tipo de software é conhecido como
“gerenciador grafico” (ver X) e é
uma parte opcional do sistema. Nao
no Mac OS X. 0 Aqua é a (nica
interface que o mortal comum deve
dominar - para nossa felicidade.

Sigla de Berkeley Software Dis-
tribution; atualmente na versao
4.4. Foi o primeiro “sabor” de
ndo-proprietario, lancado em 1979.
Desenvolvido na Universidade de
Berkeley, na Califérnia, 0 BSD aju-
dou a estabelecer a Internet em
universidades nos EUA, pois conti-
nha o protocolo TCP/IP. Ele tam-
bém é conhecido por tirar o maxi-

mo proveito da
Junto com o
forma a base do

Mach 3.0,

Biblioteca de programacao que per-
mite adaptar os softwares do Mac
0S classico ao Mac 0S X sem
perder a retrocompatibilidade nem
ter que reescrevé-los do zero. 0
software “carbonizado” pode rodar
nativamente nos dois sistemas,
preferindo abrir dentro do X no
caso de haver os dois instalados.
Nao é tao rapido quanto um progra-
ma e ndo aproveita algumas
das vantagens técnicas do X, mas é
adequado para os desenvolvedores
adaptarem seus programas mais ra-
pidamente, sem a necessidade de
recriar o software inteiro no

Secdo do Mac OS X que contém
uma “maquina virtual” para rodar o
Mac 0S 9.1 e os programas escri-
tos para ele. Ndo é um emulador,
como o Virtual PC, pois o sistema e
0s programas “falam” direto ao
processador, sem um mecanismo de
traducdo. Com quantidades ade-
quadas de memoria adicional, o seu
desempenho & igual ao do Mac 0S
9.1 “puro”.

Conjunto de ferramentas de progra- }



& O efeito agora é mais simples:
a janela simplesmente muda de

tamanho, sem deformacio.
Quando quiser retornar ao

Genie, dé 0 mesmo comando de antes, sO

que terminado em genie, ou seja:

defaults write com.apple.Dock mineffect

genie

Dé Force Quit no Dock e tudo voltard a0 que

era antes.

o

O procedimento para instalar fundos (papéis de
parede) é o mesmo dos sons, com a diferenga
de que s existe uma pasta para eles: /Librarys
Desktop Pictures. As imagens devem ser em for-
mato JPEG, GIF ou TIFE, em RGB. Se a figura for
menor que a dimensao em pixels da tela, ela
serd repetida até cobrir todo o desktop. Ou seja,
ndo existe mais a distincio entre Desktop Pic-
ture e Desktop Pattern, como havia no Mac OS
classico. A tela de fundo é mudada na janela de
preferéncias do Finder.

eoloeled

Vocé deve ter observado que, sempre que faz
um update no Mac OS X, apds a instalagao é
feita uma “otimizacao” do sistema. Mas para
que serve isso? Essa otimizacao faz um pré-
anexamento (prebinding) das bibliotecas
dinamicas (dynamic libraries). Ficou na mes-
ma? Bem, € o seguinte: a0 pré-anexar suas bi-
bliotecas dinamicas, vocé cria um indice para o
sistema com as exatas localizacoes e versoes das
bibliotecas dinamicas. Isso acelera a inicializa-
¢ao dos aplicativos, que nio precisam encontrar
sozinhos onde estao esses arquivos. Mas as ver-
soes e localizacoes de bibliotecas podem modi-
ficar-se com novas versoes instaladas. Quando
isso acontece, a pré-anexacio deixa de ser vili-
da e é ignorada. Voce pode, entretanto, atuali-
zar as informacoes no braco.

E interessante que vez ou outra seja feita essa
otimizacio. E parecido (mas nio a mesma
coisa) com o velho conhecido Reconstruir o
Desktop (Rebuild Desktop File).
Para fazer o prebinding, podemos utilizar um
programa chamado Xoptimizer (pegue-0 em
ww'w Codefab.comAunsuppor ted Koptimize _v0.1.dmg).
Ou faga isso pelo Terminal:

Para obter acesso de administrador, digite su
e dé a senha de root.

Terminal — /bin/tesh {ttypl)

~1 novato% su

Digite este comando (aten¢io com 0 espacgo
entre a palavra root e a barra):
update_prebinding -root £
O Mac OS X fard todo o trabalho sozinho.

Quando aparecer no Terminal 2 mensagem
update_prebinding done, reinicie a2 miquina.

eolaioclocles

Uma aplicacio sensacional do Mac OS X é com-
partilhar uma conexio a Internet via rede. O
OSX vem um um servico, pré-instalado, cha-
mado NAT (Network Address Translation). Ele
redireciona as conexoes TCP/IP automatica-
mente para a rede local. Todos os outros com-
putadores na rede podem se conectar a
Internet através do Mac com OS X. S6 tem um
problema: o NAT é um programa sem interface

de configuragao prépria. A boa noticia é que
existe um programinha shareware, o gNAT
(disponivel em . frognet.net/~Tachman),

que fornece essa interface e instrucoes comple-
tas de configuracdo. A ma noticia é que ele nio
funciona sempre, € por isso eis aqui também

o método pela linha de comando.

Experimente primeiro o gNAT; se nio rolar, use
as instrucoes a seguir.

Entre como r0ot.

Abra um editor de texto puro (plain text),
como o TextEdit ou (se tiver pritica) o pico ou
o vi na linha de comando. Digite o seguinte:

806
#!/bin/sh

natd -interface en0
/sbin/ipfw -f flush

Untitled 3.txt

/sbin/ipfw add divert natd all from any to any via en0
/sbin/ipfw add pass all from any to any
ifconfig en0 10.0.0.1 netmask 255.255.255.0 alias

Isso ai é o script que ird ativar o NAT e fornecer
os seus parimetros de operacio. Varios deta-
lhes irio mudar conforme o tipo da sua
conexao. O script acima estd ajustado para com-
partilhar uma conexao ADSL de IP fixo via uma
unica porta Ethernet. As variacoes possiveis sa0
as seguintes:

*eni € a interface Ethernet, usada simultanea-
mente para entrada e saida. Se o seu Mac acessa
a Internet pelo modem, use pppd em vez do
primeiro endl (o segundo end fica como estd). Se
0 Mac tiver duas portas Ethernet (desejavel por
questoes de seguranca e desempenho), voceé
pode substituir o segundo endl por enl € assim a
porta enl servird para a entrada da conexio e a
en! para distribui-la para a rede local.

* O -interface na primeira linha devera ser
mudado para -dynamic -interface se a COnexao
for via IP dindmico.

Salve o script. No caso do TextEdit, o arquivo
deve estar em texto puro (menu Format » Make
Plain Text). Dé Save As e digite, como nome do
arquivo, Jetc/re.natd — isso criard o documento

Como instalar o Mac OS X em Macs nao-G3

Para quem nio tem (ou nio pode) ter um Mac
de 1ltimo tipo com processador G3 ou G4 e
estd frustrado (e com inveja) por nao poder
instalar o Mac OS X na sua maquina, eis uma
boa noticia: existe a possibilidade de fazé-lo
rodar num Mac antigo. Nao é uma tarefa ficil e
vai exigir um pouco de coragem, muito tempo
e grandes doses de paciéncia. Se voce se julga
pronto, pode continuar a ler esta matéria.
Atenc¢do: mesmo que voce siga corretamente 0s

passos a seguir, nao existem garantias que o
procedimento vai der certo para vocé e seu
Mac. Portanto, siga em frente sabendo que isso
€ por sua conta € risco.

Nem todos os Macs antigos sao compativeis
com essa “instalacdo forcada” do Mac OS X. As
mdquinas que nao apresentaram problemas
foram os Power Macs 7300, 7500, 7600, 8500,

8600 e 9600, além dos seus respectivos clones
(os modelos que utilizam placas similares ao
7200 nao vao funcionar). Placas de upgrade de
processador também funcionam usando esse
método; porém, o cache nivel 2 nao funciona.
Para sanar esse problema, € preciso usar o pro-
grama L2CacheConfig (nttp:/shomepage.mac.com.
RuanRempel/L2CacheConfig/ReleaseMotes html).
Outra coisa importante: se vocé tem menos de
128 MB de RAM, esqueca tudo. O Mac OS X jd



re.natd dentro da pasta setc (que € normalmente invisivel no Finder).

O programa perguntard se deve anexar (append) a extensao .txt — escolha

Don’t Append.

Saveas! | fetc/rc.natd|

Where: | [l Desktop

in Text Encoding

Western (Mac OS Roman)

{ Cancel f Save )

Na linha de comando, digite
chrnod 755 fetcsronatd
para tornar o script executdvel.

Nenhuma alteragao é necessaria
nas preferéncias de rede (Net-
work) do OS X, mas os demais
computadores ligados a rede pre-
cisarao ter a sua configuracdo alterada. Abra o painel de controle TCP/IP e
de File » Configurations (&)(K)). Selecione a configuracio de Internet cor-

rente e clique em Duplicate e depois em Make Active. De volta a janela

normal do painel, modifique os seguintes campos:

* Connect via: Ethernet

* Configure: Manually

*IP Address: 10.0.0.2 (dé

esse nimero para o primeiro

Mac, 10.0.0.3 para o segundo,

10.0.0.4 para o terceiro e

assim por diante).

* Subnet Mask: 255.255.255.0

* Router Address: 10.0.0.1

No campo restante (DNS),

mantenha os dados originais.
Dé Log Out no OS X e entre

de volta como usudrio normal.
E preciso ativar o NAT ma-

nualmente a cada novo login.

Abra o Terminal, dé um zu, for-

neca a senha de root e digite:

fetesrenatd

Se funcionar, devera aparecer

uma mensagem semelhante a esta:

00000 divert 8668 ip from any to any via end

Active configuration: Cla
uplicate Configura

Duplicate “Classic” as:

\' cancel | |

@ o)

00000 allow ip from any to any
Digite exit para sair do root e feche o Terminal.

Configurations

Import...

Export...

Duplicate...
Rename...

Delete...

Os outros computadores na rede jd deverao estar enxergando a Internet
através do NAT. Para acessar as maquinas pela rede, é s6 usar os novos
enderecos IP locais: 10.0.0.2, 10.0.0.3 etc. A miquina com o OS X usa o
endereco 10.0.0.1 na rede local; para quem esta fora da rede local, o

endereco dela ¢ o IP fornecido pelo provedor .

vai ficar lento pela falta do chip
G3; pouca memoria (quanto
mais melhor, lembre-se) vai tor-
nar seu computador uma carroga
inutilizavel.

A instalagdo do Mac OS X s6 é
possivel em Macs antigos usando
alguns elementos do Darwin (o
“coracao” do X). Para conseguir
colocar 0s arquivos necessirios

}magéo (baseadas nas linguagens di-

namicas Objective-C e Java) que
foram desenvolvidas pela
para criar os sistemas operacionais
e . No Mac 0S
X, serve para a criacao de progra-
mas legacy-free, isto é, sem o com-
promisso de rodar no sistema classi-
co. Os programas feitos em Cocoa
sdo os que rodam mais eficiente-
mente no X.

Ferramenta que converte as ins-
trucdes de programacao criadas
numa linguagem de alto nivel (que
se assemelha mais ao linguajar co-
mum dos mortais, como Java

ou Basic) em um programa exe-
cutavel, que é o que o computador
ira rodar.

Tipo de programa largamente en-
contrado em sistemas e imita-
do no Mac OS cléssico e no
Windows. E um software que roda
de forma auténoma, sem inter-
vencao direta do usudrio, e atende
a algum servico, como por exemplo
o recebimento e envio de email,
gerenciamento de impressdo etc.
Em geral é acionado e controlado
pela linha de comando e por arquiv-
os de configuragdo; nao tem inter-
face gréfica. Talvez isso explique o
nome, que tem a ver com espiritos
da mitologia grega.

A parte do Mac 0S X,
que compreende o sistema eo
kernel . Existe uma versao

para chips Intel. Mas ndo
se anime muito: o Darwin contém
apenas a nao
inclui a interface

Sigla de Integrated Development
Enviroment - ambiente de progra-
macao integrado. Inclui editores de
texto, compiladores, debuggers e
outras ferramentas utilizadas no
desenvolvimento de software. No
Mac OS X, o principal IDE é o
ProjectBuilder, da Apple, que se
utiliza de padrdo co-

mo o javac da Sun e

BSD de Objective C. No Mac 0S
9.x, os IDEs existentes sdo o
CodeWarrior (da Metrowerks) e o
MPW (Macintosh Programmers
Workshop) da Apple.

Funcao do sistema operacional que
decide automaticamente a distri-
buicdo da meméria disponivel para
os programas. O Mac OS classico,
embora fosse avangado para com-
putadores pessoais nos anos 80,
nao conseguiu se modernizar nesse
aspecto. Ele ndo consegue impedir
que programas acessem indevida-
mente partes da meméria que sdo
usados por outros softwares ou
pelo sistema. O resultado? Se o
programa trava, leva o sistema
inteiro junto. O ndo
tem esse tipo de problema, sendo
impossivel para aplicativos rodando
no Mac 0S X travarem o sistema
operacional quando param de fun-
cionar normalmente.

Ao pé da letra, “caroco”. Mas
pegaria mal se a gente chamasse o
3.0, o kernel do Mac 0S X,
de “caroco do sistema”. O kernel é
a parte mais basica do sistema
operacional; ele lida diretamente
com o hardware e é responsavel
pela maioria das fungdes essenciais
do sistema. A (nica coisa que
pode travar de verdade o Mac
0S X & um pau de kernel (“kernel
panic”), o que ndo é nada comum.

Interface de usudrio baseada em

comandos digitados. E acessada

pelo programa Terminal no Mac

0S X. Ele abre automaticamente o
padrao do sistema e aguarda

suas instrugdes.

Nome do usado no Mac 0S X
(a rigor, um microkernel), desen-
volvido pela universidade Carnegie-
Mellon no inicio dos anos 90 e
adaptado pela NeXT/Apple. [ 2



B
oS a instalacdo, € preciso criar
A um CD do OS X com esses
arquivos complementares

(que devem ser baixados do site
http:/ ‘homepage.mac.cormsRuanRempels/Downloads
O1dorldSupport.ima.bin). Nesse arquivo estao
também alguns programas necessirios para
criar o disco de instalagao “falso”. Existem duas
maneiras de se criar esse CD “melhorado”: com
um gravador de CD ou usando uma particio do
HD. A primeira é mais tranquila, ja que a par-
ticao do instalador e a do Mac OS X nio estardo
no mesmo disco e vocé poderd usar o processo
de formatacio do programa de instalacio do X
para transformar a particio do Mac OS X em
“bootavel”. Mas vamos falar disso mais adiante.

Antes de mais nada, prepare-se. O que isso sig-
nifica? Becape. A gente vive repetindo que é
importante (pode acreditar, ¢ mesmo). O
becape ¢ fundamental. Portanto, copie tudo de
importante que estd guardado no seu Mac e s6
depois continue.

Para formatar o HD, basta dar partida pelo CD
de instalagio do Mac OS X ou 9.1 e rodar o
Drive Setup, que vem dentro dele. Para fazer a
instalacao do Mac OS X serd necessario dividir o
disco em trés particoes (usar HDs separados di
na mesma). Clique em Custom Setup na tela
inicial do Drive Setup para criar as particoes (o
programa as chama
de “Volumes”).
Arraste as alcas
para ajustar o ta-
manho de cada
uma conforme
desejado.

Vocé precisa ter as seguintes particoes:

¢ Particao do Mac OS X — Onde o sistema serd
instalado. Ela precisa ter, no minimo, 1,5 GB,
mas ¢ melhor ter uma folga para evitar proble-
mas. E obrigatério que o Mac OS X seja coloca-
do na primeira particio do disco, e ela nao
pode ser maior que 8 GB.

¢ Particao do Mac OS 9 — Deve conter um
System Folder do 9.1.

¢ Particao do instalador — Uma c6pia “melho-
rada” do CD do Mac OS X, com 0s arquivos a
mais do Darwin. Ela precisa ter, no minimo,
650 MB (0 mesmo tamanho de um CD).
Depois de instalado o X, vocé pode apagar o
contetdo e utilizd-la para outros fins; mas se
quiser, pode manter tudo como estd para o
caso de uma reinstalacio.

As particoes do instalador e do Mac OS X de-
verdo ser no formato HFS+ (chamado pelo
Drive Setup de Mac OS Extended). Em teoria,
voce poderia por o OS X numa parti¢o com o
formato Unix, mas os testes feitos nao deram

certo: quando é preciso acessar o Mac OS 9, que
¢ incompativel com esse formato, tudo trava.
Importante: se voce tem dois HDs no seu Mac
e resolveu deixar um HD inteiro para fazer a
instalacao, formate o HD que ser4 utilizado com
as tres particoes e instale numa delas o Mac OS
9.1 antes. Para acessar o ambiente Classic, é
preciso que o Mac OS X e 0 9.1 estejam no
mesmo disco (podem estar em particoes dife-
rentes). E até possivel instalar o X em cima do
Mac OS 9.0.x, mas vocé nao conseguird utilizar
nenhum programa nao “carbonizado”.

Chegou a hora de copiar o CD do Mac OS X
para a sua parti¢ao Instalador. Nao basta apenas
abrir o CD e arrastar todo o conteudo para a
particao: é preciso deixa-la “bootavel”.

Para fazer isso, utilize o programa Apple Soft-
ware Restore (ASR), que veio na pasta Installer
Tools do pacote baixado da Internet.

O ASR ird fazer uma copia exata do CD, incluin-
do todos os arquivos invisiveis (garantindo que
essa particao serd “inicializdvel”). Se vocé estd
tendo problemas para usar o ASR dentro do
disco imagem, copie o programa para o HD.
Geralmente d4 certo.
Se voce possui um gravador de CD e o progra-
ma Toast, vocé podera utilizar a funcio de criar
um disco imagem do CD de instalacio para usa-
la como sua parti¢io Instalador. Siga os passos:

Restarte pelo 9.

Arraste o disco de instalacio do Mac OS X
para o icone do ASR. O programa ird abrir e
selecionar o CD para ser restaurado.

Apple Software Restore

ore, saving original items
{J Restore in Place

ume Furmat:\'same as selected configuration =

Destination disk: [ Special Options

Eject Disk

[ Switch Disk

e
[_Restore ]
Escolha a particio Instalador para copiar o
conteddo do CD (seja a imagem criada pelo
Toast ou a particio do disco). Cuidado: ela serd

formatada completamente (nio esqueca de
escolher o formato HFS+).

Quando o programa acabar, vocé terd uma
versdo “bootdvel” do Mac OS X. Se a sua par-
ticdo Instalador estiver no mesmo disco da par-
ticdo Mac OS X, € preciso fazer mais uma copia
do CD de instalacao para transformar a particao
Mac OS X (aquela onde vocé vai instalar o sis-
tema) em um disco “bootdvel”. Se vocé tiver
usando um disco imagem e o gravador de CD,
pode pular esta parte e ir direto para o préximo
capitulo. Se nao, continue daqui.

Repita os passos 1 e 2 e depois escolha a par-
ticao Mac OS X para copiar os arquivos do CD.
Feita a copia, usando o Finder do 9, apague
todos os arquivos visiveis dentro da particio
Mac OS X (isto é: arraste-os para o Lixo e
esvazie). Assim, a particio Mac OS X também
serd “bootdvel” e poderd ser utilizada. Esse
processo so precisa ser feito uma vez (para o
caso de voce querer reinstalar o OS X na
mesma particao).

Agora, podemos adicionar os arquivos neces-
sarios para complementar o CD “falso” e torna-
lo compativel com Macs nio-G3. Abra a pasta
Kernel Extensions dentro do arquivo que vocé
baixou da Internet e copie todo o seu conterido
(atencdo: nao copie a pasta em si, mas sim
todas as pastas com a extensao kext separadas)
para a pasta System/Library/Extensions dentro do
CD “falso”. Com esses arquivos, vocé con-

seguird “bootar” (se tudo correr bem!).

[ kernel bxtensions

Teoricamente, vocé precisaria copiar esses mes-
mos arquivos para a particao Mac OS X, mas
existe um meio mais facil de fazer isso. Dentro
da pasta Package no disco imagem baixado da
Internet existe um pacote (que sao na verdade
os aplicativos de Mac OS X) que fard todo o
“trabalho sujo” de instalar as Kernel Extensions
nos lugares corretos dentro do sistema.

Copie a pasta DdworldSupport.pka que
vem dentro do folder Package para a
pasta System/Installation/Packages dentro da
particdo do Instalador.

Copie o arquivo OSInstalllist (que também
estd dentro da pasta Package) para o folder
Systern/snstallation/Packages/05Install.mpkgs



Contents/Resources. J4 existe um arquivo 14, com o mesmo nome.

Copie por cima.

Assim, quando vocé instalar o OS X; o programa de instalagio ird copiar os
arquivos necessarios para seu Mac antigo funcione com o X.

O Mac 0§ 9.1 tem um painel de controle chamado Startup Disk, que nor-
malmente serve para “bootar” entre 0 9.1 e o X nos novos Macs (G3 e G4).
Pois bem: nao use o painel de controle. Ele vai corromper o processo de
instalacio, vocé ficara com virias particoes sem sistema e terd que refor-
matar tudo. Portanto, mais uma vez, nao use o Startup Disk do Mac OS
9.1. Nem mesmo depois da instalagao concluida e com o Mac OS X funcio-
nando, ndo use o Startup Disk do 9.1 para trocar de sistema.

Para “bootar” pelo CD “falso”, utilize o programa System Disk que vem
dentro da pasta Installer Tools no disco imagem OldWorldSupport. Copie-o
para o seu HD para poder trocar de sistema depois da instalacio.

Se voce escolheu o método do gravador de CD, chegou a hora de
“queimar” sua copia “melhorada” do disco de instalacio do X. Depois, use
o System Disk e escolha a particao Instalador (seja ela o CD queimado ou a
particdo no HD). Restarte o Mac. Prepare-se. Se tudo correu bem, vocé estd
prestes a entrar num novo mundo.

0 instalador do Mac OS X ji deve ter aparecido na sua tela. Caso contrario,
se tudo que voceé vir forem mensagens esquisitas com a expressao “kernel
panic”, ndo se desespere. Religue o Mac com a tecla apertada e
voce voltard para o OS 9. Infelizmente, se o panic aconteceu, vocé estd
fora do jogo.

Bem, o processo de instalacio ¢ meio lento; ento, tenha um pouco de
paciéncia. Se o cursor parar de girar por um certo periodo de tempo, pode
ser algum problema. Existem chances de o processo ndo dar certo com
vocé, mas nada o impede de tentar mais uma vez. Se o problema se repe-
tir, desculpe; acabou.

Continuando tudo bem, o processo de instalacao € tranquilo. Se voce utili-
zou um CD queimado como a particio Instalador, aproveite agora para for-
matar a particao Mac OS X (isso a tornard “bootavel”). Porém, se as duas
particoes estiverem no mesmo disco, esqueca essa opcao e continue o
processo de instalacio. Leia os textos, aceite os contratos de licenca e
mande instalar o X.

Quando o programa de instalacio terminar, ele automaticamente desligard
e religard o Mac. Nio fique ansioso e aperte o botao “Restart” antes da
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pMemoéria virtual

Recurso do sistema operacional que
usa parte do HD como continuagao
da meméria RAM, pelo método de
paginacdo de memoria. No Mac 0S
classico, a meméria virtual tem
tamanho pré-definido pelo usuario;
no OS X, é ilimitada. Quanto maior
a proporcdo da memoria paginada
no HD para a RAM existente, mais
lento fica o computador.

Multitarefa

A capacidade de fazer mais de uma
coisa ao mesmo tempo. Na ver-
dade, os programas nao rodam ao
mesmo tempo, mas em rodizio. O
tempo do processador é dividido
em “fatias” para cada programa.
Isso vale para qualquer computador
moderno, incluindo o Mac. Nao
acredite nos pecezistas desinforma-
dos: 0 Mac OS classico €, sim, mul-
titarefa. A diferenca é que ele tem
multitarefa cooperativa - um es-
quema onde os proprios programas
decidem o quanto usam da CPU e
quanto deixam para os outros; uma
coisa meio “anarco-sindicalista”. No
sistema de multitarefa preemptiva
do Mac 0S X, é o sistema opera-
cional que define qual programa vai
usar a CPU e por quanto tempo de
cada vez, o que garante que ne-
nhum software fique paralisado por
causa de outro. No Mac 0S X é
possivel fazer coisas impossiveis no
sistema classico, como mandar abrir
um programa e fazer outra coisa em
vez de ficar esperando, ou arrastar
uma janela do Finder na frente de
um filme QuickTime e o filme con-
tinuar tocando sem interrupgao.

Multiusuario

A capacidade de atender a mais de
uma pessoa individual e separada-
mente. Tipico exemplo de sistema
assim é um servidor da Internet. O
Unix & multiusuario desde crianci-
nha; sistemas mais recentes, como
0 Mac 0S classico, foram tomados
multiusuario, ganhando uma estru-
tura de arquivos similar, comparti-
mentada por pessoa. Cada usuario
tem um conjunto limitado de coisas
que pode manipular na maquina; é o

chamado “dominio”. Os problemas
de seguranga em redes sempre en-
volvem pessoas tendo acesso a
coisas fora do seu dominio.

NeXT

Empresa criada por Steve Jobs no
periodo em que esteve fora da
Apple (1985-97). L4, ele desen-
volveu o computador NeXT Cube e
o sistema operacional NextSTEP,
rebatizado como OpenSTEP quando
foi portado para outras plataformas
de hardware além do Cube. Com
uma porcao de modificagoes, esse
sistema acabou virando aquilo que
conhecemos hoje como Mac 0S X e
Mac 0S X Server. Todos eles tém
em comum o fato de serem basea-
dos em BSD e no kernel Mach.

Open source

Qualquer software cujo autor abre
mao do sigilo intelectual, fornecen-
do-o junto com o codigo-fonte (o
programa ndo compilado) para que
possa ser estudado, aperfeicoado e
(em alguns casos) redistribuido por
outras pessoas. Muitos softwares
de Unix sdo open source; o Linux é
a Unica versdo 100% open source
do Unix. 0 Mac 0S X segue um
esquema misto: o Darwin é open
source, mas 0 Agua nao.

Paginacdo de meméria

Funcdo bésica da memoria virtual.
Nela, o sistema transfere automati-
camente para o HD as partes do
contetido da memdria RAM menos
frequentemente utilizadas e as Ié
de volta do HD para a RAM a medi-
da que sdo invocadas pelos proces-
sos. Cada porcdo da memoria assim
armazenada é chamada de “pagi-
na”. Em Macs com pouca memoria
RAM, vocé pode ouvir o HD pagi-
nando furiosamente a memoria
enquanto o Mac OS se arrasta para
cumprir uma tarefa “pesada”.

Portar

Converter um software de um
sistema operacional para outro.
Muitos softwares de Unix podem

ser portados para o Mac 0S X

sem grande esforco. | 2



hora. Tenha paciéncia. Como
dissemos, a instalacio é um
pouco demorada, mas o melhor
€ nao interferir no processo.
Se nao houver nenhum outro problema,
parabéns! Voce € um novo Cavaleiro da Ordem
de X. Divirta-se! (Porém, se nao deu certo, s6
podemos pedir desculpas. N6s avisamos no
comeco que isso poderia acontecer.)
Durante o processo de configuracio do Mac OS
X, se tudo correr bem, ele deverd reconhecer o

Linha de comando:

Para o bem ou para o mal, a linha de comando
no Mac OS X é uma realidade. Vocé nio precisa
se preocupar com ela: todas as operacoes
importantes podem ser feitas em lindas janelas
com interface Aqua. Mas sempre existe aquela
curiosidade, aquela vontade de saber, afinal, o
que d4 pra fazer nesse tal de Terminal. Para os
curiosos, iniciamos aqui um ripido cursinho de
Unix no OS X. Aprendendo aos poucos, voce
vai perceber que esse tal de Unix € até, com o
perdao da palavra, intuitivo.

Uma das primeiras coisas que devemos apren-
der para tirar proveito da linha de comando em
qualquer sistema operacional Unix é como
navegar pelos seus arquivos. Felizmente isso é
muito facil, mas nao é imediatamente evidente
para quem nunca teve contato direto com a
linha de comando.

Inicie o Terminal, encontrado em
#pplications/Utilities. Quando vocé abre a janela
do Terminal, surge o prompt. E um prefixo que,
além de receber seus comandos, mostra a sua
localizacio dentro do computador e o seu
nome de usudrio (o qual, para a finalidade do
nosso exemplo, chamamos de novato.)

A localizacio no prompt funciona assim: o
Terminal inicia a sessao em seu diretdrio pes-
soal (Home), que é a mesma coisa que a pasta
que tem o seu nome, dentro da pasta Users.
Para ver em qual pasta (ou, em bom “unixés”,
diretorio) voce estd a qualquer momento, digite
pwil. Isso destaca para voce o seu diretorio de
trabalho. O comando retorna isto:

Terminal — /bin/iesh (itypl)

novato% pwd

modem externo conectado pela porta serial (no
caso de vocé ter um e usi-lo para se conectar a
Internet). Sem ele, nao hd jeito de usar a Inter-
net e voce terd uma miquina com um bonito
sistema operacional, mas isolada do mundo.

Mas, antes que vocé corra para mostrar para 0s
amigos a sua proeza de instalar o Mac OS X
num Mac “n20-G3”, hd ainda mais alguns pas-
sos a serem seguidos. Primeiramente, abra o

System Preferences e escolha o painel de con-
trole Energy Saver. Coloque a op¢io de nunca
(never) dormir (sleep) para os discos rigidos (a
op¢ao do monitor pode ficar ligada sem proble-
mas, mas por via das davidas...).

Outro cuidado importante: se voce tem dois
HDs e deixou um deles com o sistema 9.0.x
instalado, ndo escolha a pasta desse sistema
operacional para “bootar” novamente para o
sistema antigo. Utilize sempre a pasta do Mac
0S 9.1 (que vem marcada com um “9”). Assim,

vocé ainda vai usar uma

A segunda linha € a resposta a0 comando. O
valor /lzers/novato significa que voceé estd na
pasta Home do usudrio chamado novato, que no
€aso € vocé mesmo.

Para visualizar o contetudo da pasta em que
vocé se encontra, digite:
I3
Digitando esse comando 1z no diretdrio Home,
voce obterd alguma coisa como:

Terminal — /bin/tesh (ttypl)

Musie

Existem diversas opcoes que voce pode utilizar
para alterar o modo como o comando 1= apre-
senta as informacoes. Digitando 1z -1 vocé terd
informagoes mais detalhadas ou a versio longa
da lista, que apresenta o diret6rio por colunas
com as permissoes, datas e proprietarios de
cada arquivo e cada subdiret6rio.

Terminal — /bin/tcsh (ttypl)

Digitando 1z -a voce terd uma lista completa
(all) do contedado do diretorio, incluindo os
itens ocultos (aqueles cujo nome comeca

com ponto).

Vocé pode também combinar essas opgoes em
um comando Unico, digitando 1z -al.
Voltemos a0 exemplo. Por enquanto, nao se

preocupe se vocé nao entender nada do que
estd escrito na tela:

Terminal — /bin/tesh (ttypl)

Agora, vamos mudar de pasta. Digamos que
voce estd no seu diretorio Home e gostaria de ir
para o diretdrio Music, visualizado no quadro
anterior. Para fazer isso, vocé deve utilizar o
comando cd, digitando cd Music.

Vocé perceberd que o prompt do Unix (a parte
da linha de comando que precede o cursor)
mudou para mostrar que agora voce estd no
diretorio ~/Iusic.

Terminal — /bin/tesh (ttypl)

O til (~) € o jeito como o Unix chama a sua
pasta Home. O diret6rio Home para o usudrio
novato ¢ fUsers/novato. Entdo, digitar

~{Music € exatamente o mesmo que digitar
fUsersdnovatosMusic.

Se voce digitar o comando 1= -a, vai ver dois
itens com nomes inusitados: . (ponto) e .. (dois
pontos). Eles sempre estio presentes em cada
pasta. O ponto Unico refere-se a pasta em que
voce se encontra. O ponto duplo (.) refere-se
ao diret6rio que contém o diret6rio onde vocé
se encontra. Se vocé estiver no diretorio
Users/novato/Music, ponto duplo refere-se ao
diretdrio /Users/novato,

Para visualizar os dados de um diret6rio
localizado dentro daquele em que vocé se
encontra, digite o comando cd seguido do
nome do diretério que deseja visualizar.
Digitando cd .. vocé retorna para o diretdrio



tem-se a garantia de boots mais seguros e sem problemas como os de o
Mac deixar de reconhecer um dos HDs, 0 modem externo e o som, além
de ficar mais lento.

Lembre-se: todo esse processo nao € recomendado pela Apple, mas funcio-
na. Se voce se sentia um pdria por nao poder usar o X, agora pode se sen-
tir melhor. E claro que seu Mac vai ficar mais lento. Algumas vezes o

Mac OS X vai demorar demais para “bootar” (e serd preciso apertar
(3)(Control)(«) vArias vezes até o OS X “pegar no tranco”). Mas esse é o preco
de se ter um sistema ultramoderno num Mac genuinamente cldssico.

anterior (ou superior, se preferir) na hierarquia de arquivos.

Para retornar ao seu diretorio Home de qualquer lugar onde estiver, digite
cd sem nenhum argumento adicional. Digitando cd ~ ou cd /Users/novato
voce terd 0 mesmo
efeito, mas perderd
mais tempo digitando
sem necessidade.

Terminal = /bin/tcsh (ttypd)

~1 novato% cd movies

O caractere / ¢ como o Unix denomina a raiz, que em inglés ¢ chamada
de root (mas nao confunda esse root com o super-usuario, também chama-
do root) do sistema de arquivos. A partir desse diretorio, digitando cd ..
nao acontecerd nada, pois voce jd se encontra no topo da hierarquia.

Usar o simbolo barra () antes do nome de um diretério significa procurar
o diretdrio a partir do root em vez do diret6rio onde vocé se encontra.
Entdo, enquanto cd Users ird buscar por um diretorio Users onde voce se
encontra, cd flsers ird buscar o diretdrio Users no inicio da hierarquia de
arquivos. Voce pode ir diretamente para qualquer diret6rio, simplesmente
digitando o caminho completo para chegar até ele.

Terminal — /hin/tesh (ttyp1)

Pratique a movimenta-
¢ao através dos diretdrios
utilizando esses comandos
até sentir-se habituado.
Utilize pwd para verificar sua
localizacdo e 1= para mostrar
o conteudo do diretorio. Vocé pode ver diretamente o contetido de um
diretorio qualquer digitando o caminho completo para chegar até ele, uti-
lizando se necessario os atalhos ~ e ..

Existe uma maneira mais “macintdshica” de saber onde um determinado
arquivo estd guardado, usando o velho conhecido “arraste e solte” (drag
and drop). Com o Terminal aberto, arraste o item cuja localizagio vocé
deseja saber para cima da janela do programa. A resposta do Terminal serd
o nome de caminho completo do local onde o arquivo se encontra, sendo
que o nome do item serd a ultima coisa do caminho.

Isso € 0 que vocé precisa para navegar utilizando a linha de comando.
Claro que € apenas o inicio; existem inimeras outras combinagoes de co-
mandos. Digite na janela de terminal man 1z, man cd ou man pwd para visua-
lizar o manual com as informagoes sobre cada um desses comandos.

Cada programa individual rodando
no computador. Abra o utilitario
ProcessViewer, que vem com o Mac
0S X, para ter uma lista dos proces-
sos ativos, incluindo varios que ndo
aparecem no Dock. O Process-
Viewer também serve para “matar”
(Force Quit) os programas.

Programacdo na qual grande parte
do codigo é formada por objetos,
mddulos que podem ser reutilizados
no mesmo software ou em soft-
wares diferentes, acelerando o
desenvolvimento do aplicativo.

Avancado sistema de visualizacdo
grafica 2D criado pela Apple, basea-
do na tecnologia PDF (Portable
Document Format) da Adobe. E o
sucessor do antigo QuickDraw. E
ele que desenha os menus e janelas
transliicidos, fontes e icones com
anti-aliasing, animacdes e as outras
frescuras lindas do

Programa situado entre o usuario e
o sistema operacional puro, com o
qual é possivel entrar comandos de
texto. O shell interpreta e manda o
sistema executar os seus coman-
dos. No Mac OS X, ele é apresen-
tado pelo aplicativo Terminal. Se-
gundo a Apple, é possivel realizar
qualquer tarefa sem um shell, mas
por via das dividas, o Terminal esta
ali, pronto para usar. O shell usado
no Mac 0S X é o tcsh. Ele tem al-
guns comandos diferentes do bash,
0 shell mais popular no Linux.

Um programa rodando, s6 isso.
Alguns o chamam de

Literalmente: fio. Tarefa indepen-
dente rodando dentro de um pro-
grama. Um aplicativo multithreaded
pode ter dois ou mais threads sen-
do executados ao mesmo tempo,
com o sistema operacional determi-
nando qual deles sera prioritério.

Assim, uma operacao roda em se-
gundo plano e ndo interfere em ou-
tro thread ou programa que esta
ativo. Um exemplo é quando vocé
navega na Internet com seu brow-
ser e ao mesmo tempo baixa arqui-
VOs e carrega paginas da Web em
outras janelas do mesmo browser.

Sistema operacional e

inventado nos labo-
ratorios Bell, no final dos anos 60.
Impedido de ser comercializado nos
Estados Unidos por causa das leis
antitruste, ele foi oferecido em
1976 as universidades norte-ame-
ricanas, que comegaram a desen-
volver versoes diferenciadas do sis-
tema. Nos dltimos 20 anos o Unix
teve dezenas de “filhotes”, alguns
deles livres (. ') e outros
nao, sendo os mais famosos o
Linux, o FreeBSD e o Solaris, e
agora também o Mac 0S X. 0 Unix,
por sua natureza flexivel e pau-pra-
toda-obra, & muito utilizado em
universidades e na infra-estrutura
da Internet. A propria Internet e
seus protocolos foram criados em
maquinas Unix, a partir de 1969; a
Web foi inventada em um computa-
dor em 1991.

NAO é sinénimo de Mac OS X.

X é o apelido do X-Window Sys-
tem, gerenciador grafico do Unix.
Ele é dividido em duas partes: o
cliente (a parte que gera a interface
grafica) e o servidor (a parte que
exibe a interface de janelas e me-
nus). A idéia da divisao é que eles
ndo precisam estar necessariamente
na mesma maquina, permitindo que
um computador com o servidor rode
remotamente os softwares da ma-
quina cliente. Atualmente, na maio-
ria dos casos, o cliente e o servidor
residem na mesma maquina. O Mac
0S X ndo vem com um servidor X-
Window, mas ja existem implemen-
tacbes comerciais e .
Um Mac 0S X sem servidor X-Win-
dow pode rodar um programa X-
Window, desde que sua visualizacao
aconteca em outro computador que
possua o servidor.



